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Acronyms in This Document 
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1. Introduction 
This document describes the Human Presence Detection design process using an iCE40 UltraPlus™ FPGA platform 
(HiMax HM01B0 UPduino Shield). 

1.1. Design Process Overview 
The design process involves the following steps: 

1. Training the model 

 Setting up the basic environment 

 Preparing the dataset. 

 Preparing the 64 x 64 image 

 Labeling dataset of human bounding box 

 Training the machine 

 Training the machine and creating the checkpoint data  

 Creating the frozen file (*.pb) 

2. Compiling Neural Network 

 Creating the binary file with Lattice SensAI 2.1 program 

3. FPGA design 

 Creating the FPGA Bitstream file 

4. FPGA Bitstream and Quantized Weights and Instructions 

 Flashing the binary and bitstream files to iCE40 UPduino hardware 

 

Figure 1.1. Lattice Machine Learning Design Flow 
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2. Setting up the Basic Environment 

2.1. Software and Hardware Requirements 
This section describes the required tools and environment setup for training and model freezing. 

2.1.1. Software 

 Lattice Radiant Software 
Refer to http://www.latticesemi.com/latticeradiant 

 Lattice Radiant Programmer 
Refer to http://www.latticesemi.com/programmer 

 Neural Network Compiler version 2.1 
Refer to https://www.latticesemi.com/Products/DesignSoftwareAndIP/AIML/NeuralNetworkCompiler 

2.1.2. Hardware 

This design uses the HiMax HM01B0 UPduino Shield as shown in Figure 2.1. 
Refer to http://www.latticesemi.com/en/Products/DevelopmenBoardsAndKits/HimaxHM01B0. 

 

Figure 2.1. HiMax HM01B0 UPduino Shield Board 

http://www.latticesemi.com/legal
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2.2. Setting up the Linux Environment for Machine Training 
This section describes the steps for NVIDIA GPU drivers and/or libraries for 64-bit Ubuntu 16.04 OS.  

Note: NVIDIA library and TensorFlow version is dependent on PC and Ubuntu/Windows version.  

2.2.1. Installing the NVIDIA CUDA and cuDNN Library for ML Training on GPU 

2.2.1.1. Installing the CUDA Toolkit 

To install the NVIDIA CUDA toolkit, run the commands below:  

1. Download the NVIDIA CUDA toolkit. 

$ curl -O 

https://developer.download.nvidia.com/compute/cuda/repos/ubuntu1604/x86_64/cu

da-repo-ubuntu1604_10.1.105-1_amd64.deb 

 

Figure 2.2. CUDA Repo Download 

2. Install the deb package. 

$ sudo dpkg -i ./cuda-repo-ubuntu1604_10.1.105-1_amd64.deb 

 

Figure 2.3. CUDA Repo Installation 

3. Proceed with the installation. 

$ sudo apt-key adv --fetch-keys 

http://developer.download.nvidia.com/compute/cuda/repos/ubuntu1604/x86_64/7fa

2af80.pub 

 

Figure 2.4. Fetch Keys 

$ sudo apt-get update 

 

Figure 2.5. Updated Ubuntu Package Repositories 

http://www.latticesemi.com/legal
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sudo apt-get install cuda-9-0 

 

Figure 2.6. CUDA Installation Completed 

2.2.1.2. Installing the cuDNN 

To install cuDNN: 

1. Create your NVIDIA developer account in https://developer.nvidia.com. 

2. Download the cuDNN library from https://developer.nvidia.com/compute/machine-
learning/cudnn/secure/v7.1.4/prod/9.0_20180516/cudnn-9.0-linux-x64-v7.1. 

3. Run the commands below to install cuDNN: 

$ tar xvf cudnn-9.0-linux-x64-v7.1.tgz  

$ sudo cp cuda/include/cudnn.h /usr/local/cuda/include  

$ sudo cp cuda/lib64/libcudnn* /usr/local/cuda/lib64  

$ sudo chmod a+r /usr/local/cuda/include/cudnn.h 

/usr/local/cuda/lib64/libcudnn* 

 

Figure 2.7. cuDNN Installation 

2.2.2. Setting Up the Environment for Training and Model Freezing Scripts 

This section describes the environment setup for training and model freezing scripts for 64-bit Ubuntu 16.04.  

Anaconda provides one of the easiest ways to perform machine learning development and training on Linux. 

2.2.2.1. Installing the Anaconda and Python3 

To install the Anaconda and Python 3: 

1. Go to https://www.anaconda.com/distribution/#download. 

2. Download Python 3 version of Anaconda for Linux. 

 

Figure 2.8. Anaconda Package Download 

http://www.latticesemi.com/legal
https://developer.nvidia.com/
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file:///C:/Users/bleigh/OneDrive%20-%20Lattice%20Semiconductor%20Corp/Documents/Documents/Lattice/ML-AI/2019-Q2%20sensAI2.0/from%20https:/developer.nvidia.com/compute/machine-learning/cudnn/secure/v7.1.4/prod/9.0_20180516/cudnn-9.0-linux-x64-v7.1
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3. Run the command below to install the Anaconda environment. 

$ sh Anaconda3-2019.03-Linux-x86_64.sh    

Note: Anaconda3-<version>-Linux-x86_64.sh version may vary based on the release. 

 

Figure 2.9. Anaconda Installation  

4. Accept the license. 

 

Figure 2.10. License Terms Prompt 

5. Confirm the installation path. Follow the instructions onscreen to change the default path. 

  

Figure 2.11. Installation Path Confirmation 

6. After installation, enter No as shown in Figure 2.12.  

 

Figure 2.12. Launch/Initialize Anaconda Environment on Installation Completed 

  

http://www.latticesemi.com/legal


 Human Presence Detection Using Compact CNN Accelerator IP 
 Reference Design 
 

© 2019 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-RD-02059-2.1  13 

2.2.3. Installing TensorFlow v1.12  

To install the TensorFlow v1.12: 

1. Activate the conda environment by running the command below: 

$ source <conda  directory>/bin/activate 

 

Figure 2.13.Anaconda Environment Activation 

2. Install the TensorFlow by running the command below: 

$ conda install tensorflow-gpu==1.12.0 

 

Figure 2.14. TensorFlow Installation  

3. After installation, enter Y as shown in Figure 2.15. 

 

Figure 2.15. TensorFlow Installation Confirmation 

Figure 2.16 shows TensorFlow installation is completed. 

 

Figure 2.16. TensorFlow Installation Completed 
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2.2.4. Installing the Python Package 

To install the Python package:  

1. Install Easydict by running the command below. 

$ conda install -c conda-forge easydict 

 

Figure 2.17. Easydict Installation 

2. Install joblib by running the command below. 

$ conda install joblib 

 

Figure 2.18. Joblib Installation  

3. Install Keras by running the command below. 

$ conda install keras 

 

Figure 2.19. Keras Installation 

4. Install OpenCV by running the command below. 

$ conda install opencv 

 

Figure 2.20. OpenCV Installation 
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5. Install Pillow by running the command below. 

$ conda install pillow 

 

Figure 2.21. Pillow Installation 
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3. Preparing the Dataset 
This chapter describes how to create a dataset using examples from Google Open Image Dataset. 

The Google Open Image Dataset version 4 (https://storage.googleapis.com/openimages/web/index.html) features 
more than 600 classes of images. The Person class of images include human annotated and machine annotated labels 
and bounding box. Annotations are licensed by Google Inc. under CC BY 4.0 and images are licensed under CC BY 2.0. 

3.1. Downloading the Dataset 
To download the dataset, run the commands below. 

1. Clone the OIDv4_Toolkit repository. 

$ git clone https://github.com/EscVM/OIDv4_ToolKit.git 

$ cd OIDv4_ToolKit 

 

Figure 3.1. Open Source Dataset Repository Cloning 

Figure 3.2 shows the OIDv4 directory structure. 

 

Figure 3.2. OIDv4_Toolkit Directory Structure 

View the OIDv4 Toolkit Help menu. 

$ python3 main.py -h 

http://www.latticesemi.com/legal
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Figure 3.3. Dataset Script Option/Help 

2. Use the OIDv4 Toolkit to download dataset. Download Person class images. 

$ python3 main.py downloader --classes Person --type_csv validation 

 

Figure 3.4. Dataset Downloading Logs 

Figure 3.5 shows the downloaded dataset directory structure. 

 

Figure 3.5. Downloaded Dataset Directory Structure 

3. Lattice training code uses KITTI (.txt) format. The downloaded dataset is not in the required KITTI format. Convert 
the annotation to KITTI format. 

$ sed -i -- 's/Person/Person 0 0 0/g' OID/Dataset/validation/Person/Label/* 

$ sed -i -- 's/Person/Person 0 0 0/g' OID/Dataset/train/Person/Label/* 

$ sed -i -- 's/Person/Person 0 0 0/g' OID/Dataset/test/Person/Label/* 

 

Figure 3.6. OIDv4 Label to KITTI Format Conversion 

Note: KITTI Format: Person 0 0 0 324.61 69.90 814.56 681.90. It has class ID followed by truncated, occluded, 
alpha, Xmin, Ymin, Xmax, Ymax. The code converts Xmin, Ymin, Xmax, Ymax into x, y, w, h while training as 
bounding box rectangle coordinates. 
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3.2. Visualizing and Tuning/Cleaning Up the Dataset 
To visualize and annotate the dataset, run the commands below: 

1. Visualize the labelled images. 

$ python3 main.py visualizer 

 

Figure 3.7. Toolkit Visualizer 

2. Clone the manual annotation tool from the GitHub repository. 

$ git clone https://github.com/SaiPrajwal95/annotate-to-KITTI.git 

 

Figure 3.8. Manual Annotation Tool – Cloning 

3. Go to annotate-to-KITTI. 

$ cd annotate-to-KITTI 

$ ls 

 

Figure 3.9. Manual Annotation Tool – Directory Structure 
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4. Install the dependencies (OpenCV 2.4). 

$ sudo apt-get install python-opencv 

5. Launch the utility 

$ python3 annotate-folder.py 

6. Set the dataset path and default object label.  

 

Figure 3.10. Manual Annotation Tool – Launch 

7. For annotation, run the script provided in the website below. 

https://github.com/SaiPrajwal95/annotate-to-KITTI 

For more information on other labelling tools, see Appendix A. Other Labelling Tools. 

3.3. Data Augmentation 
Data Augmentation needs large amount of training data to achieve good performance. Image Augmentation creates 
training images through different ways of processing or combination of multiple processing such as random rotation, 
shifts, shear and flips, and so on. 

 

Figure 3.11. Augmentation Directory Stucture 

 data_aug – It contains basic methods and augmentation classes. 

 augmentation.py – This file reads the input images (input labels) and performs preferred augmentation on it. 

 config.py – Contains parameters that are used in augmentation operations. 

3.3.1. Configuring the Augmentation 

To configure the augmentation: 

1. Configure the config.py file which contains the parameters shown in Figure 3.12. 

 

Figure 3.12. config.py Configuration File Parameters  
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2. Choose the operations to perform on the dataset. The operations can be selected in augmentation.py by editing 
the list all_op. 

 

Figure 3.13. Selecting the Augmentation Operations 

3. Add or Remove the operation by commenting/uncommenting the operation in the all_op list as shown in Figure 
3.13. 

3.3.2. Running the Augmentation 

Run the augmentation by running the command below: 

python augmentation.py --image_dir <Path_To_InputImage_Dir> --label_dir 

<Path_To_InputLabel_Dir> --out_image_dir <Path_To_OutputImage_Dir> --

out_label_dir <Path_To_OutputLable_Dir> 

 

Figure 3.14. Running the Augmentataion 
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4. Training the Machine 

4.1. Training Code Structure 

 

Figure 4.1. Training Code Directory Structure 
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4.2. Neural Network Architecture 

4.2.1. Neural Network Architecture 

This section provides information on the Convolution Network Configuration of the Human Presence Detection design. 
The Neural Network model of the Human Presence Detection design uses VGG NN base model and the detection layer 
of SqueezeDet model. 

Table 4.1. Convolution Network Configuration of Human Presence Detection Design 

Image Input (64 x 64 x 3) 

Fire 1 Conv3 – 16 Conv3 - # where: 

 Conv3 – 3 x 3 Convolution filter Kernel size 

 # - The number of filter 

For example, Conv3 - 16 = 16 3 x 3 convolution filter 

 

BN – Batch Normalization 

 

FC - # where: 

 FC – Fully connected layer 

 # - The number of output 

BN 

Relu 

Maxpool 

Fire 2 Conv3 – 16 

BN 

Relu 

Fire 3 Conv3 – 32 

BN 

Relu 

Maxpool 

Fire 4 Conv3 – 32 

BN 

Relu 

Fire 5 Conv3 – 32 

BN 

Relu 

Maxpool 

Fire 6 Conv3 – 44 

BN 

Relu 

Fire 7 Conv3 – 48 

BN 

Relu 

Maxpool 

Conv12 Conv3 – 42 
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Figure 4.2. Model Layer Dimensions 

 The Human Detection network structure consists of seven fire layers followed by one convolution layer. Fire layer 
contains convolution, batch normalization, and relu layers. Fire 1, Fire 3, Fire 5, and Fire 7 layers contain pooling, 
while Fire 2, Fire 4, and Fire 6 layers do not contain pooling. 

 In Table 4.1, the layer contains convolution (conv), batch normalization (bn), and relu layers. 

 Figure 4.2 shows the dimensions of each layer of the network. 

 Layer information: 

 Convolutional Layer 

In general, the first layer in a CNN is always a convolutional layer. Each layer consists of number of filters 
(sometimes referred as kernels) which convolves with input layer/image and generates activation map (that is 
feature map). This filter is an array of numbers (the numbers are called weights or parameters). Each of these 
filters can be thought of as feature identifiers, like straight edges, simple colors, and curves and other high-
level features. For example, the filters on the first layer convolve around the input image and activate (or 
compute high values) when the specific feature (for example,curve) it is looking for is in the input volume. 
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 Relu (Activation Layer) 

After each conv layer, it is convention to apply a nonlinear layer (or activation layer) immediately afterward. The 
purpose of this layer is to introduce nonlinearity to a system that basically has just been computing linear 
operations during the conv layers (element-wise, multiplications, and summations). In the past, nonlinear 
functions like tanh and sigmoid were used, but researchers found out that ReLU layers work far better because 
the network is able to train a lot faster (because of the computational efficiency) without making a significant 
difference to the accuracy. The ReLU layer applies the function f(x) = max (0, x) to all of the values in the input 
volume. In basic terms, this layer just changes all the negative activations to 0. This layer increases the nonlinear 
properties of the model and the overall network without affecting the receptive fields of the conv layer. 

 Pooling Layer 

After some ReLu layers, you may choose to apply a pooling layer. It is also referred to as a down sampling layer. 
In this category, there are also several layer options, with max pooling being the most popular. This basically 
takes a filter (normally by size 2 x 2) and a stride of the same length. It then applies to the input volume and 
outputs the maximum number in every sub region that the filter convolves around.  

The intuitive reasoning behind this layer is that once you know that a specific feature is in the original input 
volume (there is a high activation value), its exact location is not as important as its relative location to the 
other features. This layer drastically reduces the spatial dimension (the length and the width change but not 
the depth) of the input volume. This serves two main purposes. First is that the number of parameters or 
weights is reduced by 75%, thus lessening the computation cost. Second is that it controls over fitting. This 
term refers to when a model is so tuned to the training examples that it is not able to generalize well for the 
validation and test sets. A symptom of over fitting is having a model that gets 100% or 99% on the training set, 
but only 50% on the test data. 

 Batch Normalization 

Batch Normalization layer reduces the internal covariance shift. In order to train a neural network, perform 
preprocessing to the input data. For example, you can normalize all data so that it resembles a normal 
distribution (that means, zero mean and a unitary variance). This is to prevent the early saturation of non-
linear activation functions like the sigmoid function, assuring that all input data is in the same range of values, 
and so on. 

But the problem appears in the intermediate layers because the distribution of the activations is constantly 
changing during training. This slows down the training process because each layer must learn to adapt 
themselves to a new distribution in every training step. This problem is known as internal covariate shift. 

The Batch Normalization layer forces the input of every layer to have approximately the same distribution in 
every training step by following below process during training time:  

 Calculate the mean and variance of the layers input. 

 Normalize the layer inputs using the previously calculated batch statistics. 

 Scale Layer scales and shifts in order to obtain the output of the layer. 

This makes the learning of layers in the network more independent of each other and allows you to be care 
free about weight initialization, works as regularization in place of dropout, and other regularization 
techniques. 

The architecture above provides nonlinearities and preservation of dimension that help to improve the robustness of the 
network and control over fitting. 
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4.2.2. Human Presence Detection Network Output 

From the input image model first extracts feature maps, overlays them with a WxH grid and at each cell computes K 
pre-computed bounding boxes called anchors. Each bounding box has the following: 

 Four scalars (x, y, w, h) 

 A confidence score ( Pr(Object)xIOU ) 

 C° conditional class probability 

 The current model architecture has a fixed output of WxHxK(4+1+C) where: 

 W , H = Grid Size 

 K = Number of Anchor boxes 

 C = Number of classes for which you want detection 

 The model has a total of 672 output values which are derived from the following: 

 4 x 4 grid 

 7 anchor boxes per grid 

 6 values per anchor box. It consists of: 

 4 bounding box coordinates (x, y, w, h) 

 1 class probability 

 1 confidence score 

So in total, 4 x 4 x 7 x 6 = 672 output values. 

 

Figure 4.3. Model Output Format 
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4.2.2.1. Model Output Format on Hardware 

 In hardware, the Human Presence Detection demo works based on confidence score. Other output values like class 
probability and bbox coordinates are byproduct which are not used at all. 

 If the last layer in the network is Convolution, CNN IP supports partial output processing based on given filter 
range. SensAI tool provides option to specify the required filter range from the convolution layer output. This also 
results in hardware performance improvement. 

 In Human Presence demo, the last convolution layer has 42 filters as described in Neural Network Architecture 
section. Out of 42, the first seven filters give class probability values; the next seven are for confidence score, and 
the rest for bbox coordinates. 

 By configuring output depth range as shown in Figure 6.4, CNN only gives 112 confidence values as output. 

4.2.3. Training Code Overview 

 

Figure 4.4. Training Code Flow Diagram 
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Training code is divided into the following parts: 

 Model Config 

 Model Building 

 Model Freezing 

 Data Preparation 

 Training for Overall Execution Flow 

Details of each can be found in subsequent sections. 

4.2.3.1. Model Config 

The design uses the Kitti dataset and SqueezeDet model. kitti_squeezeDet_config.py maintains all the configurable 
parameters for the model. Below is a summary of the configurable parameters: 

 Image size 

 Change mc.IMAGE_WIDTH and mc.IMAGE_HEIGHT to configure Image size (width and height) in 
src/config/kitti_squeezeDet_config.py 

 

Figure 4.5. Code Snippet – Input Image Size Config 

 Since there are four pooling layers, grid dimension would be H = mc.IMAGE_WIDTH/(2 ^ 4) and W = 
mc.IMAGE_ HEIGHT/(2 ^ 4). Update grid size anchors per grid in set_anchors() in 
src/config/kitti_squeezeDet_config.py, that is if image size is 64 x 64, H = 64 / 16 = 4 and W = H = 64 / 16 = 4. 

 

Figure 4.6. Code Snippet – Input Image Size Config (Grid Sizes) 

 Batch size 

 Change mc.BATCH_SIZE in src/config/kitti_squeezeDet_config.py to configure batch size. 

 

Figure 4.7. Code Snippet – Batch Image Size Config 

 Anchors per Grid 

 Change mc.ANCHOR_PER_GRID in src/config/kitti_squeezeDet_config.py to configure anchors per grid. 

 

Figure 4.8. Code Snippet – Anchors per Grid Config #1 

 Change hard coded anchors per grid in set_anchors() in src/config/kitti_squeezeDet_config.py.  
Here, B (value 7) indicates anchors per grid. 

http://www.latticesemi.com/legal


Human Presence Detection Using Compact CNN Accelerator IP  
Reference Design 
 

© 2019 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

28   FPGA-RD-02059-2.1 

 

Figure 4.9. Code Snippet – Anchors per Grid Config #2 

 anchor_shapes variable of set_anchors() in src/config/kitti_squeezeDet_config.py indicates anchors width and 
heights. Update it based on anchors per grid size changes. 

 

Figure 4.10. Code Snippet – Anchors per Grid Config #3 

 Training parameters 

 Other training related parameters like learning rate, loss parameters, and different thresholds can be 
configured from src/config/kitti_squeezeDet_config.py. 

 

Figure 4.11. Code Snippet – Training Parameters 
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4.2.3.2. Model Building 

SqueezeDet class constructor builds the model which is divided into the following sections: 

 Forward Graph 

 Interpretation Graph 

 Loss Graph 

 Train Graph 

 Visualization Graph 

Forward Graph 

 Forward Graph consists of seven fire layers. 

 Each fire layers contains a 3 x 3 convolution layer with padding=SAME and stride=1, a batch normalization 
layer, ReLU layer and an optional max pool layer. Out of these three fire layers, fire 2, fire 4, and fire 6 layers do 
not use max pool. 

 These seven fire layers are followed by a 3 x 3 convolution layer with padding=SAME and stride=1. 

 Filter sizes of each convolutional blocks is mentioned in Table 4.1, which can be configured by changing the values 
of depth shown in Figure 4.12. 

 

Figure 4.12. Code Snippet – Quantization Value Setting 

 

Figure 4.13. Code Snippet – Forward Graph Fire Layers 
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Figure 4.14. Code Snippet – Forward Graph Last Convolution Layer 

 8-bit quantization is performed on weights and activations in this model. Based on the value of w_bin and 
a_bin, it is decided whether or not you should perform quantization. 

 

Figure 4.15. Code Snippet – Quantization Layer 

Interpretation Graph 

 The Interpretation Graph consists of the following sub-blocks: 

 interpret_output 
As mentioned in Figure 4.3, model output is 4 x 4 x 42. There are 42 channels in the last layers which contain 
probability for the class, confidence score and bounding boxes values.  
This block interprets output from network and extracts predicted class probability, confidence score and 
bounding box values. From training code output value processing perspective, for each grid: 

 First N values (0:N-1) contains probabilities. Where N is number of anchor boxes. For N = 7, this ranges 
from 0 to 6 (including 6). 

 Next N values (N:2N – 1) contains confidence score. Where N is number of anchor boxes. For N = 7, this 
ranges from 7 to 13 (including 13). 

 Last 2N * 4 values contain bounding boxes information. Where N is number of anchor boxes. For N = 7, 
this ranges from 14 to 41 (including 41). 

The code below shows how the output from conv12 layer (4d array of batch size x 4 x 4 x 42) is sliced with 
proper indexes to get all values of probability, confidence, and coordinates.  

http://www.latticesemi.com/legal


 Human Presence Detection Using Compact CNN Accelerator IP 
 Reference Design 
 

© 2019 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-RD-02059-2.1  31 

 

Figure 4.16. Code Snippet – Interpret Output Graph  

For confidence score, value should be between 0 and 1, so sigmoid is used. 

For predicting the class probabilities, there is a vector of NUM_CLASS values at each bounding box. Applying softmax 
makes it a better probability distribution. 

 Bbox - This block calculates bounding boxes based on anchor box and predicated bounding boxes. 

 IOU – This block calculates Intersection Over Union for detected bounding boxes and actual bounding boxes. 

 Probability – This block calculates detection probability and object class. 
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Loss Graph 

 This block calculates the different types of losses which need to be minimized. There are three types of losses 
which are considered for calculation: 

 Class Probability 

The class loss function is just cross-entropy loss for classification for each box to do classification (predicted 
class versus actual class), as you would for image classification. 

 

Figure 4.17. Code Snippet – Class Loss 

 Bounding Box 
This loss is regression of the scalars for the anchors. 

 

Figure 4.18. Code Snippet – Bbox Loss 

 Confidence Score 
To obtain meaningful confidence score, each box’s predicted value is regressed against the Intersection over 
Union of the real and the predicted box. During training, compare the ground truth bounding boxes with all 
anchors and assign them to the anchors that have the largest overlap (IOU) with each of them.  

The reason being is to select the closest anchor to match the ground truth box such that the transformation 
needed is reduced to minimum. Equation evaluates to 1 if the k-th anchor at position-(i, j) has the largest 
overlap with a ground truth box, and to 0 if no ground truth is assigned to it. This way, include only the loss 
generated by the responsible anchors.  

As there can be multiple objects per image, normalize the loss by dividing it by the number of objects 
(self.num_objects). 
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Figure 4.19. Code Snippet – Confidence Loss 

Train Graph 

 This block is responsible for training the model with momentum optimizer to reduce all losses. 

Visualization Graph 

 This provides visualization of detected results. 

4.3. Training from Scratch and/or Transfer Learning 
To train the machine: 

1. Go to the top/root directory of the Lattice training code from command prompt. 

The Model works on 64 x 64 input resolution for training. 

Current human detection training code uses mean = 0 and scale = 1/128 (0.0078125) in pre-processing step. Mean 
and scale can be changed in training code @src/dataset/imdb.py as shown in Figure 4.20. 

 

Figure 4.20. Training Code Snippet for Mean and Scale 

The dataset path can be set in the training code @src/dataset/kitti.py and can be used in combination with the --
data_path option while triggering training using train.py to get the desired path. For example, you can have 
<data_path>/training/images and <data_path>/training/labels. 

 

Figure 4.21. Training Code Snippet for Dataset Path 
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2. Create a train.txt.  

$ cd data/humandet/ 

$ python dataset_create.py 

 

Figure 4.22. Create File for Dataset train.txt 

Notes: 

 train.txt – file name of dataset images. 

 image_set – train (ImageSets/train.txt) 

 data_path – $ROOT/data/humandet/. 

 Images – $ROOT/data/humandet/images 

 Annotations – $ROOT/data/humandet/labels 

3. Modify the training script. 

Training script at @scripts/train.sh is used to trigger training. Figure 4.23 shows the input parameters which can be 
configured. 

 

Figure 4.23. Training Input Parameter  

 $TRAIN_DATA_DIR – dataset directory path. /data/humandet is an example. 

 $TRAIN_DIR – log directory where checkpoint files are generated while model is training. 

 $GPUID – gpu id. If the system has more than one gpu, it indicates the one to use. 

 --summary_step – indicates at which interval loss summary should be dumped. 

 --checkpoint_step – indicates at which interval checkpoints is created. 

 --max_steps – indicates the maximum number of steps for which the model is trained. 

4. Execute the run command script which starts training. 

 

Figure 4.24. Execute Run Script 
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5. Start TensorBoard. 

$ tensorboard –logdir=<log directory of training> 

For example: tensorboard –logdir=’./logs/’ 

6. Open the local host port on your web browser. 

  

Figure 4.25. TensorBoard – Generated Link 

7. Check the training status on TensorBoard. 

 

Figure 4.26. TensorBoard 

Figure 4.27 shows the image menu of TensorBoard. 

 

Figure 4.27. Image Menu of TensorBoard 
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8. Check if the checkpoint, data, meta, index, and events (if using TensorBoard) files are created at the log directory. 
These files are used for creating the frozen file (*.pb). 

 

Figure 4.28. Example of Checkpoint Data Files at Log Folder 
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5. Creating Frozen File 
This section describes the procedure for freezing the model, which is aligned with the Lattice SensAI tool. Perform the 
steps below to generate the frozen protobuf file: 

5.1. Generating the frozen .pb File 
Generate .pb file from latest checkpoint using below command from the training code’s root directory. 

$ python src/genpb.py –ckpt_dir=”<log directory>” --freeze 

For example, python src/genpb.py –ckpt_dir ’./logs/humandet/train/’ –freeze. 

 

Figure 5.1. pb File Generation from Checkpoint 

Figure 5.2 shows the generated .pb file. 

 

Figure 5.2. Frozen pb File 
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6. Creating Binary File with SensAI 
This chapter describes how to generate binary file using the Lattice SensAI version 2.1 program. 

 

Figure 6.1. SensAI Home Screen 

To create the project in SensAI tool: 

1. Click File > New. 

2. Enter the following settings: 

 Project Name 

 Framework – TensorFlow 

 Class – CNN  

 Device – UltraPlus 

3. Click Network File and select the network (PB) file. 
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Figure 6.2. SensAI –Network File Selection 

4. Click Image/Video/Audio Data and select the image input file. 

 

Figure 6.3. SensAI –Image Data File Selection 

5. Click NEXT. 

6. Configure your project settings. 
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Figure 6.4. SensAI – Project Settings 

7. Click OK to create project. 

8. Double-click Analyze. 

 

Figure 6.5. SensAI – Analyze Project 

9. Double-click Compile to generate the Firmware file. 
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Figure 6.6. Compile Project 
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7. Hardware (RTL) Implementation 

7.1. Top Level Information 

7.1.1. Block Diagram 

 

Figure 7.1. Top Level Block Diagram Human Presence Detection iCE40 

7.1.2. Overall Operational Flow 

 The external camera is configured via I2C Master block for desired camera settings right after the system is 
powered up. The camera captures the real-time image data and sends it to the iCE40 Ultra Plus device.  

 The input image data is passed through Video Processing module which performs Crop and Downscale operation 
which makes input resolution compatible for CNN model and maintains the aspect ratio. Current CNN model 
requires 64 x 64 input resolution. 

 CNN IP uses the image data with the firmware file from the external SPI Flash and does the inference and 
generates output.  

 CNN output is passed to Post Processing module which processes output to find out the maximum value. This 
value is utilized to take decision of driving the LED output.  

 In this demo, there are six LED lights with potential to turn. According to the parameter MIRROR_MODE 
configuration, the demo has two following output representations: 

 Configuration 1 (MIRROR_MODE = 0) 

 Human Presence is detected and given as output in form of six LEDs. From top to bottom: 

 LED D1 represents human detection in Upper Left of the screen, 

 LED D2 represents human detection in Upper Right of the screen, 

 LED D3 represents human detection in Lower Left of the screen, 

 LED D4 represents human detection in Lower Right of the screen, 

 LED D5 represents human detection in Center of the camera, 

 LED D6 represents human detection in the Full image. 
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 Configuration 2 (MIRROR_MODE = 1) 

 Human Presence is detected and given as output in form of one LED:  

 LED D5 represents human detection in the Full image.  

7.1.3. Core Customization 

Table 7.1. Core Parameters 

Parameter Default 
(Decimal) 

Description 

MIRROR_MODE 1 1 – Single LED output if Human Presence Detected 

0 – Six LED output according to Human Presence Detected in any of the six 
zones. 

BYTE_MODE UNSIGNED Configured for CNN input data layer width. It is to be kept according to the 
Mean parameter setting from software training. 

UNSIGNED – The data is directly passed to CNN input for unsigned 8-bit 
input data layer. 

SIGNED – 128 is subtracted from the data for signed 8-bit input data layer of 
CNN. 

DISABLED – Disable byte mode 

 

7.2. Architectural Details 

7.2.1. CNN Pre-Processing 

7.2.1.1. MIRROR_MODE=0 (Zoning Enabled) 

 

Figure 7.2. Image Zoning Enabled 
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 The camera output provides full frame image data which can be divided into six zones according to the value of frame 

zone counter. The Frame Zone counter is implemented in the top module as shown in Figure 7.3, and it counts from 

0 to 5 (6 values) mapping each count value to each zone. By default, it is set to 0.  

 When Frame Zone Counter is 0, the Upper Left of Image data is utilized for CNN input. Counter is incremented when 

CNN starts processing that Data. The Upper Right of image data is utilized for CNN input for counter value 1.  

The frame zone counter values are mapped to frame zones as follows: 

 count 0 – Upper Left Zone  

 count 1 – Upper Right Zone 

 count 2 – Lower Left Zone 

 count 3 – Lower Right Zone 

 count 4 – Center Zone 

 count 5 – Full Image Zone 

 

Figure 7.3. RTL logic – Zone Counter 

7.2.1.2. Zoning and Downscaling (ice40_himax_video_process_128.v) 

 

Figure 7.4. Masking for Zone 1 

Image data values are streamed continuously from input camera serial interface. 

The horizontal/vertical masking is performed on the input image to mask out the boundary area to make the image 

resolution in multiple of CNN input resolution (64 x 64). The pixel values of image under mask area are not considered 

valid. Masking makes the downscaling process easier.  
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7.2.1.3. Downscaling for Zones 1-5 

 Mask values are set according to the current active image zone. For zones 1 to 5, masking produces image resolution 

of 256 x 128 from full image frame as shown in the Figure 7.4. 

 As shown in Figure 7.4 when Zone 1 is active, whole image is masked apart from upper left 256 x 128 pixel block. 256 

x 128 resolution image data is then downscaled to 64 x 64 resolution in video processing module as explained below. 

 

Figure 7.5. Downscaling Zones 1-5 

 As shown in the Figure 7.5, Every 4 horizontal (256/64) and 2 vertical (128/64) pixel which make pixel grid of 4 x 2 

are accumulated into a single pixel value to generate 64 x 64 resolution image for CNN input.  

 The accumulated RGB pixel values are written into accumulation buffer. As every 64 values are written into the 

memory, Data from memory is read and transferred to CNN. This way, the 4096 (64 x 64) red, green, and blue pixel 

values are passed on to CNN input. 

7.2.1.4. Downscaling for Zone 6 (Full Image Zone) 

 

Figure 7.6. Downscaling Zone 6 
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 For zone 6, masking produces image resolution of 512 x 256 from full image frame as shown in Figure 7.6. The image 

data is then downscaled into 64 x 64 resolution. 

 As shown in the Figure 7.6, Every 8 horizontal (512/64) and 4 vertical (256/64) pixel which make pixel grid of 8 x 4 

are accumulated into a single pixel value to produce 64 x 64 resolution image for CNN input.  

 The accumulated RGB pixel values are written into accumulation buffer. As every 64 values are written into the 

memory, data from memory is read and transferred to CNN. This way, the 4096 (64 x 64) red, green, and blue pixel 

values are passed to CNN.  

7.2.1.5. MIRROR_MODE=1 (Zoning Disabled) 

 

Figure 7.7. Image Zoning Disabled 

 The Frame Zoning is disabled in this configuration. The camera output image data is not divided into different 
frame zones but it is treated as Full image Zone as shown in Figure 7.7. 

 The Frame Zone counter which is common for both the MIRROR_MODE configurations is kept at full frame zone 

count value (that is count=5) as shown in the Figure 7.3.  

 By default, the full frame zone (that is zone-6) is always enabled in the operation flow. 

 The camera output image resolution is masked and downscaled according to zone-6 as described in Downscaling 
for Zone 6 (Full Image Zone) section. 

7.2.2. CNN Post-Processing (humandet_post.v) 

 CNN provides 112 output values as described in Model Output Format on Hardware section. These values are 
confidence score for 7 anchor boxes of each 4 x 4 grid (4 x 4 x 7 = 112). Post processing logic in this module is 
independent of number of values provided by CNN. 

 The post processing logic finds out the maximum value from all the confidence values provided by CNN output using 

RTL logic as shown in Figure 7.8.  

http://www.latticesemi.com/legal


 Human Presence Detection Using Compact CNN Accelerator IP 
 Reference Design 
 

© 2019 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-RD-02059-2.1  47 

 

Figure 7.8. RTL Logic – Maximum CNN Value Calculation 

 The calculated maximum value (w_class0 signal) is passed to Top module. The maximum value is considered valid 
only if it is a positive value i.e. SIGN bit (Highest bit) is 0. The SIGN Bit is used to take decision of driving the LED as 
shown in below RTL logic.  

 The frame zone counter count value determines which LED to drive. 

 

Figure 7.9. RTL Logic – Driving Output LED Logic[1] 

 

Figure 7.10. RTL Logic – Driving Output LED Logic[2] 

7.2.2.1. MIRROR_MODE=0 (Zoning Enabled) 

From above RTL logic, LEDs are driven as following for frame zone counter values: 

 Count 0 → LED 1 (UL) is ON (if Max CNN output value SIGN Bit = 0) 

 Count 1 → LED 2 (UR) is ON (if Max CNN output value SIGN Bit = 0) 

 Count 2 → LED 3 (LL) is ON (if Max CNN output value SIGN Bit = 0) 

 Count 3 → LED 4 (LR) is ON (if Max CNN output value SIGN Bit = 0) 

 Count 4 → LED 5 (Center) is ON (if Max CNN output value SIGN Bit = 0) 

 Count 5 → LED 6 (Full) is ON (if Max CNN output value SIGN Bit = 0) 
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7.2.2.2. MIRROR_MODE=1 (Zoning Disabled) 

The frame zone counter is assigned fixed value of count 4 which drives the LED 5 as follows: 

 Count 4 → LED 5 (Center) is ON (if Max CNN output value SIGN Bit = 0) 
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8. Creating FPGA Bitstream File 
This section provides the procedure for creating your FPGA bitstream file using Lattice Radiant Software. 

Note: This reference design includes a Compact CNN IP that requires a license to be able to generate a bitstream. 
Lattice provides a 30-day evaluation license for this IP for those who want to evaluate the IP and reference design. You 
can obtain an evaluation license from the Lattice website Software Licensing page.  

Lattice Radiant software version 1.1 is required to generate a bitstream along with a software license patch. You can 
obtain the software patch file from the Lattice website through Lattice Radiant 1.1 Software Patch. 

To create the FPGA bitstream file: 

1. Open Lattice Radiant Software. 

 

Figure 8.1. Radiant Software 

2. Click File > Open Project. 

3. Open the Radiant project file for iCE40 human presence detection RTL. 
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Figure 8.2. Radiant Software – Open Project 

4. Click Export to generate the bit file. 

 

Figure 8.3. Radiant Software – Bitstream Generation 

5. View the log message in Export Reports that indicates the generated bitstream path. 
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Figure 8.4. Radiant Software – Bitstream Generation Export Report 
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9. Running the iCE40 Human Presence Detection Demo 

9.1. Functional Description 
Figure 9.1 shows the diagram of the Human Presence demo. The camera captures the image data and sends it to the 
iCE40 UltraPlus device. iCE40 UltraPlus then uses the image data with the firmware file from the external SPI Flash to 
determine the outcomes. 

 

Figure 9.1. iCE40 Human Presence Demo Diagram 

9.2. Programming Human Presence Detection Demo on iCE40 SPI Flash 
This section provides the procedure for programming the SPI Flash on the HiMax HM01B0 UPduino Shield Board. 

Two different files should be programmed into the SPI Flash. These files are programmed to the same SPI Flash, but at 
different addresses: 

 Bitstream 

 Firmware 

To program the SPI Flash in Radiant Programmer: 

1. Connect the HiMax HM01B0 UPduino Shield board to the PC using a micro USB cable. Note that the USB connector 
on board is delicate, so handle it with care. 

2. Start Radiant Programmer. 

3. In the Radiant Programmer Getting Started dialog box, select Create a new blank project. 

4. Click OK. 
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Figure 9.2. Radiant Programmer – Creating New Project 

5. In the Radiant Programmer main interface, set Device Family to iCE40 UltraPlus. 

 

Figure 9.3. Radiant Programmer – iCE40 UltraPlus Device Family Selection 

6. Set Device to iCE40UP5K. 
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Figure 9.4. Radiant Programmer – iCE40 UltraPlus Device Selection 

7. Select the iCE40 UltraPlus row and select Edit > Device Properties. 

8. In the Device Properties dialog box, apply the settings below that are common to the two files to program. 

Under Device Operation, select the options below: 

 Target Memory – External SPI Flash Memory 

 Port Interface – SPI 

 Access Mode – Direct Programming 

 Operation – Erase, Program, Verify 

Under SPI Flash Options, select the options below: 

 Family – SPI Serial Flash 

 Vendor – Winbond 

 Device – W25Q32 

 Package – 8-pin SOIC 

9. To program the bitstream file, select the options below as shown in Figure 9.5. 

 Under Programming Options, select the human presence detection bitstream file in Programming file. 

 Click Load from File to update the Data file size (Bytes) value. 

 Ensure that the following addresses are correct: 

 Start Address (Hex) – 0x00000000 

 End Address (Hex) – 0x00010000 
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Figure 9.5. Radiant Programmer – Bitstream Flashing Settings  

10. Click OK. 

11. In the main interface, click Program Device to program the iCE40 human presence detection bitstream file. 

12. To program the binary firmware file, select the options below as shown in Figure 9.6. 

 Under Programming Options, select the human presence detection firmware binary file in Programming file. 

 Click Load from File. Change Data file size (Bytes) value to 93140. 

 Ensure that the following addresses are correct: 

 Start Address (Hex) – 0x00020000 

 End Address (Hex) – 0x00030000 
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Figure 9.6. Radiant Programmer – Firmware Bin File Flashing Setting  

13. Click OK. 

14. In the main interface, click Program Device to program the binary file. After programming the files, perform a 
power cycle to start running the demo. 
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9.3. Running iCE40 Human Presence Detection Demo on Hardware 
To run the demo and observe results on the board:  

1. Power ON the HiMax HM01B0 UPduino Shield Board. 

Avoid any bright background.  

2. Position a human in front of the camera. Based on MIRROR_MODE configuration led turns on. For 
MIRROR_MODE=0 led turns on based on MIRROR_MODE=0 (Zoning Enabled) section and for MIRROR_MODE=1 
led turns on based on MIRROR_MODE=1 (Zoning Disabled) section. 

3. An LED light turns on if a human is detected in its section. Note that Upper Left is the camera’s Upper Left.  

Refer to Figure 9.7. for the location of camera and LED lights.  

Camera

Upper Left

Upper Right

Lower Left

Lower Right

Center

Full

 

Figure 9.7. Camera and LED Location 
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Appendix A. Other Labelling Tools 
Table A.1 provides information on other labelling tools. 

Table A.1. Other Labelling Tools 

Software Platform License Reference Converts 
To 

Notes 

annotate-to-
KITTI 

Ubuntu/Windows 
(Python based 
utility) 

No License 
(Open 
source 
GitHub 
project) 

https://github.com/SaiPrajwal95/annotate-to-
KITTI 

KITTI Python based 
CLI utility. 
Just clone it 
and launch. 
Simple and 
Powerful. 

LabelBox JavaScript, HTML, 
CSS, Python  

Cloud or 
On-
premise, 
some 
interfaces 
are 
Apache-2.0 

https://www.labelbox.com/ json, csv, 
coco, voc 

Web 
application 

LabelMe Perl, JavaScript, 
HTML, CSS, On 
Web 

MIT 
License 

http://labelme.csail.mit.edu/Release3.0/ xml Converts only 
jpeg images 

Dataturks On web Apache 
License 2.0 

https://dataturks.com/ json Converts to 
json format 
but creates 
single json file 
for all 
annotated 
images 

LabelImg ubuntu OSI 
Approved:: 
MIT 
License  

https://mlnotesblog.wordpress.com/2017/12/
16/how-to-install-labelimg-in-ubuntu-16-04/ 

xml Need to 
install 
dependencies 
given in 
reference 

Dataset_ 

annotator 

Ubuntu 2018 

George 
Mason 
University 
Permission 
is hereby 
granted, 
Free of 
charge 

https://github.com/omenyayl/dataset-
annotator 

json Need to 
install 
app_image 
and run it by 
changing 
permissions 
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References 
 Google Tensorflow Object Detection Github 

 Pretrained TensorFlow model for object detection 
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 Train model using TensorFlow 
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Technical Support Assistance 
Submit a technical support case through www.latticesemi.com/techsupport. 
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Revision History 
Revision 2.1, October 2019 

Section Change Summary 

All Changed document title from Human Presence Detection Using Compact CNN to Human 
Presence Detection Using Compact CNN Accelerator IP. 

Preparing the Dataset Added Data Augmentation section. 

Training the Machine Updated Neural Network Architecture and Training from Scratch and/or Transfer Learning 
section. 

Creating Frozen File Removed Generating pbtxt File section. 

Creating Binary File with SensAI Updated figures. 

Hardware (RTL) Implementation Newly added section. 

Running the iCE40 Human 
Presence Detection on Demo  

Updated figures in Programming Human Presence Detection Demo on iCE40 SPI Flash and 
Running iCE40 Human Presence Detection Demo on Hardware section. 

 

Revision 1.0, May 2019 

Section Change Summary 

All Initial release. 
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